
Наложение Зависимостей на Эскиз

Когда Mechanical Desktop определяет эскиз, он накладывает  геометрические
зависимости согласно внутренним правилам. Для полного определения эскиза, Вы
накладываете параметрические размеры и дополнительные геометрические
зависимости. В любой момент, Вы можете изменить эскиз и параметрическая геометрия
сохраняет отношения между конструктивными элементами.

Для уменьшения числа зависимостей, требуемых для полного определения эскиза, Вы
можете использовать конструктивную геометрию. Конструктивная геометрия становится
частью эскиза, но игнорируется, когда эскиз используется для создания элемента.

Ключевые термины

Термин Определение
2D constraint

(2D зависимость)

Определяет, как эскиз может изменять форму или размер.
Геометрические ограничения контролируют форму и зависимости
между линиями и дугами эскиза. Размерные зависимости
контролируют размер эскизной геометрии

Degree of freedom

(степень свободы)

При моделировании детали она определяет как геометрические тела
типа линии, дуги или круга могут изменять форму или размер.
Например, круг имеет две степени свободы, центр и радиус. Когда
эти значения известны считается, что степени свободы отсутствуют.

Dimensional constraint

(размерная зависимость)

Параметрический размер, который управляет размером эскиза. При
его изменении - эскиз изменяет размеры. Может быть выражен как
постоянное значение, переменная в уравнении, переменная в
таблице или в файлах глобальных параметров.

Geometric constraint

(геометрическая
зависимость)

Контролирует форму и зависимости между геометрическими
элементами в эскизе.

Parametrics

(параметрический)

Метод решения, который использует значения параметров детали
для определения геометрического профиля детали.
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Краткий Обзор Урока

Новые особенности в этом уроке

Mechanical Desktop имеет много инструментов для увеличения производительности при
создании Вами проектов. В этой главе Вы увидите, как новые и улучшенные элементы
помогают Вам редактировать и накладывают зависимости на ваши эскизы:

• Новые упражнения с зависимостями.

• Новая зависимость фиксации местоположения, заменившая фиксирующую точку,
предложенную в предыдущих версиях.

• Пересмотренная проектная зависимость, автоматически включающая режимы
объектной привязки при выборе ограничиваемой геометрии.

• Выбор команд из контекстно-зависимого меню.

Дополнительную информацию по новым и усовершенствованным элементам, см. главу
3, «Новые элементы» в руководстве «Начинаем работать».

Базовая Концепция Параметрических Построений

После того, как Вы определили эскиз, Вы накладываете геометрические и размерные
зависимости для определения его формы и размера. Эти зависимости уменьшают
степени свободы между элементами эскиза и, таким образом, определяют его конечную
форму.

Как Вы узнали в предыдущем уроке, Mechanical Desktop накладывает некоторые
геометрические зависимости при определении эскиза. Эти зависимости определяются
формой геометрии эскиза. В большинстве случаев, эскизы должны быть полностью
ограничены перед тем, как они будут использованы для создания элементов,
составляющих деталь. При полном ограничении эскиза, Вы можете легко управлять
каждым элементом его формы.

Для полного ограничения определенного эскиза, Вы добавляете геометрические и
размерные зависимости. Вы можете также добавлять конструктивную геометрию к
вашему эскизу для уменьшения числа дополнительных требуемых зависимостей.
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Советы При Построениях
Mechanical Desktop накладывает зависимости когда Вы преобразуете упрощенный эскиз
в эскиз профиля, траектории или линии сечения. Затем, в зависимости от того, насколько
точно Вы сделали эскиз, вероятно потребуется добавить одну или более зависимостей.
Программа запросит это у Вас в ходе работы. Эти советы помогут Вам определить
стратегию наложения зависимостей.

Совет Пояснение
Определите зависимости в эскизе Проанализируйте проект, чтобы определить, как

взаимодействуют между собой зависимости
элементов эскиза; затем решите – какие
геометрические зависимости необходимы

Проанализируйте автоматически
наложенные зависимости

Определите степени свободы не определенные
автоматически наложенными зависимостями.
Решите, следует ли удалить некоторые
автоматические зависимости для ограничения
требуемых элементов

Используйте только необходимые
зависимости

Заменяйте, при необходимости, зависимости для
определения формы. Поскольку зависимости
часто определяют более одной степени свободы,
используйте меньше зависимостей, чем степеней
свободы.

Установите форму до
образмеривания

Если Вы накладываете геометрические
зависимости перед размерными, менее
вероятно, чтобы форма Вашего эскиза
исказилась

Определяйте большие размеры
перед маленькими

Для минимизации искажений, определите
большие элементы, которые определяют общий
размер эскиза. Образмеривание маленьких
элементов первыми может ограничить
габаритный размер. Удалите или отмените
размер, если форма эскиза исказится.

Используйте и геометрические
зависимости, и размеры

Некоторые комбинации зависимостей могут
исказить неограниченные части эскиза. Если так,
то удалите последнюю зависимость и
рассмотрите использованные размеры или
различные комбинации зависимостей.

Вообще, используйте автоматически накладываемые зависимости для стабилизации
формы эскиза. После того, как Вы добавите последующие зависимости, Вам может
потребоваться удалить некоторых из наложенных зависимостей. По мере приобретения
опыта, Вы сможете определять, какие зависимости контролируют форму эскиза согласно
вашему требованию к конструкции.
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Наложение зависимостей на эскиз
Наложение зависимостей на эскиз определяет, как эскиз может изменять форму или
размер. В дополнение к решениям программного обеспечения, Вам часто будут
требоваться дополнительные размеры или зависимости.

Зависимости могут быть фиксированными или переменными, но они всегда
предотвращают нежелательные изменения элемента, когда Вы проводите какие либо
изменения.

Варианты, которыми эскиз может изменять размер или форму называются степенями
свободы. Например, круг имеет две степени свободы - положение центра и радиус. Если
центр и радиус определены, круг полностью ограничен и могут применяться различные
значения.

Точно так же дуга имеет четыре степени свободы - центр, радиус и конечные точки
сегмента дуги.

Степени свободы, которые Вы определяете, соответствуют тому, насколько эскиз
ограничен. Если Вы определяете все степени свободы, дуга полностью ограничена.
Если Вы не определяете все степени свободы, эскиз – не полностью определен
(underconstrained).

Mechanical Desktop не позволяет Вам определять степень свободы более, чем одним
способом и, таким образом, предохранит Вас от переопределения (overconstraining)
эскиза.

Прежде, чем Вы добавите зависимости, изучите ваш эскиз и, затем, решите, как его
ограничить. Обычно, Вам будут требоваться и геометрические зависимости, и размеры.
См. «Советы При Построениях» на странице 44.

Вы должны полностью ограничить эскизы таким образом, чтобы они изменялись
ожидаемым образом при любых модификациях. По мере приобретения опыта Вам может
потребоваться эскиз без зависимостей, когда Вы работаете с закоординированными
точками, но в этом случае элемент может исказиться при изменении размеров или
зависимостей.
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Наложение Геометрических Зависимостей
Наложении зависимостей на эскиз начинается с определения его полной формы; до
определения размеров. Геометрические зависимости определяют ориентацию и
отношения геометрических элементов. Например:

• Зависимости, которые определяют ориентацию, указывают, является ли элемент
горизонтальным или вертикальным.

• Зависимости, которые определяют отношения, определяют, являются ли два
элемента перпендикулярными, параллельными, касательными, коллинеарными,
концентрическими, проецируемыми, соединенными, имеющими одинаковые
координаты X или Y или имеющими одинаковый радиус.

Mechanical Desktop отображает зависимости геометрического объекта в виде букв. Если
зависимость определяет отношения между двумя элементами, за буквой следует номер
элемента эскиза, к которому зависимость привязана. В примере:

• начальная точка линии (0) имеет зависимость фиксации местоположения. Эта точка
зафиксирована и не будет двигаться при изменении зависимостей эскиза.

• Линии (0, 1, 3, и 5) имеют символы зависимостей H (горизонтально) или V
(вертикально).

• Все линии, за исключением одной, касательны к, по крайней мере, одной из дуг (2 и
6). Каждый символ T (касательно) сопровождается номером дуги, к которой он
касателен.

• Каждая дуга касательна к ее соединительным линиям, что показано символами
зависимости T, и они имеют одинаковый радиус, что обозначено символами
зависимости R.

По мере наложения геометрических зависимостей, Вы должны продолжать
анализировать ваш эскиз, рассматривая и изменяя зависимости.

В следующем упражнении, Вы познакомитесь с методами наложения зависимостей,
анализируя и изменяя геометрические зависимости для изменения эскиза.

Откройте файл sketch5.dwg в папке desktop\tutorial. Используйте эскизы до- и после-,
приведенные ниже, чтобы определить, какие изменения нужно сделать. Затем измените
зависимости и посмотрите результаты вашего анализа.
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ОБРАТИТЕ ВНИМАНИЕ Сделайте резервную копию файлов учебных чертежей, чтобы
Вы имели оригинальные файлы на случай ошибки. См. «Резервное Копирование Файлов
Учебных Чертежей» на странице 7.

В эскизах до- и после-, Вы видите, что зависимости и размеры отличаются, но Вы не
можете видеть, какие геометрические зависимости наложил Mechanical Desktop.
Обратите внимание что:

• Линейные размеры одинаковы для обоих эскизов.

• Углы вертикальных линий отличаются.

Отображение Символов Зависимостей

Вы можете изменять параметрические отношения линий, изменяя геометрические или
размерные зависимости. Поскольку геометрические зависимости контролируют всю
форму эскиза, Вы не можете безбоязненно проводить какие либо изменения, пока не
узнаете текущие геометрические зависимости. Поэтому, следующим шагом будет
отображение символов.

Для отображения символов зависимостей
1. Покажите символы зависимости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Show Constraints.

Пиктограмма Show Constraints

Меню Desktop Part → 2D Constraints → Show Constraints

Команда  AMSHOWCON

2. Отобразите все символы.
Enter an option [All/Select/Next/eXit] <eXit>: Введите а

Параллельные зависимости наложены на линии 0, 2, 4 и 6. Линии 1, 3, 5 и 7 имеют
горизонтальные зависимости. Линии 3 и 7 также коллинеарны и равны по длине.

Начните изменять ваш эскиз, удаляя параллельные зависимости.
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Для понимания зависимостей, посмотрите на символ Р0 (на линии 2). Этот символ
указывает, что линия 2 параллельна линии 0.

Точно так же символы зависимостей (P2, P4, и P6) показывают, что линия 0 параллельна
линиям 2, 4 и 6.

3.  Скройте символы зависимости.
Enter an option [All/Select/Next/eXit] <eXit>: Нажмите ENTER

Замена Зависимостей

После того, как Вы удалите ненужные зависимости, Вы можете добавлять зависимости
для изменения эскиза. Добавьте вертикальные зависимости к линиям.

Для замены зависимостей
1. Удалите параллельные зависимости, которые контролируют внутренние и внешние

наклонные линии.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Delete Constraints.

Пиктограмма Delete Constraints

Меню Desktop Part → 2D Constraints → Delete Constraints

Команда  AMDELCON

2. Ответьте на запросы  следующим образом:
Select or [Size/All]: Выберите символы параллельных зависимостей (1), (2), and (3)

Select or [Size/All]: Нажмите ENTER

После удаления параллельных зависимостей форма эскиза останется такой же, пока Вы
не добавите зависимости или не измените размеры.
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3. Добавьте вертикальные зависимости к двум внутренним наклонным линиям.

Контекстное Меню  В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Vertical.

Пиктограмма  Vertical

Меню Desktop  Part → 2D Constraints → Vertical

Команда  AMADDCON

4. Ответьте на запросы следующим образом:
Valid selection(s): line, ellipse or Spline segment

Select object to be reoriented: Укажите линию (3)

Solved underconstrained sketch requiring 2 Dimensions or constraints.

Valid selection(s): line, ellipse or Spline segment

Select object to be reoriented: Укажите линию (4)

Solved underconstrained sketch requiring 1 Dimensions or constraints.

Valid selection(s): line, ellipse or Spline segment

Select object to be reoriented: Нажмите ENTER

[Hor/Ver/PErp/PAr/Tan/CL/CN/PRoj/Join/XValue/YValue/Radius/Length/Mir/Fix]

<eXit>: Нажмите ENTER

После добавления вертикальных зависимостей, Ваш эскиз должен быть похожим на
следующую иллюстрацию.

Вы удалили зависимости, которые заставляли эти линии быть параллельными друг
другу. Чтобы заставить внешние линии находится под углом друг к другу, Вы должны
добавить угловой размер к крайней левой линии.

5. Установите текущим слой AM_PARDIM.

Пиктограмма Layers

Меню Desktop Assist → Format → Layers

Команда Layers



Mechanical Desktop Tutorials Release 4

50 Глава 2  Наложение Зависимостей на Эскиз

6. В диалоговом окне Layer(Слой), выберите AM_PARDIM и укажите Current (Текущий).
Нажмите ОК для выхода из диалогового окна.

7. Добавьте угловой размер.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

8. Ответьте на запросы  следующим образом:
Select first object: Щелкните возле середины линии (1)

Select second object or place dimension: Щелкните возле середины линии (2)

Specify dimension placement: Разместите размер (3)

Enter dimension value or [Undo/Placement point] <75>: Введите 105

Solved fully constrained sketch.

Select first object: Нажмите ENTER

ОБРАТИТЕ ВНИМАНИЕ Если Вы выберете линии не около их средних точек, Вас могут
запросить указать тип создаваемого размера. В этом случае выберите Angular (Угловой).

Вы успешно завершили модификацию схемы геометрических зависимостей для
изменения формы эскиза.

Сохраните ваш файл.

Далее, Вы научитесь использовать параметрические размеры для ограничения формы
эскиза.
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Наложение Размерных Ограничений
Вообще, рекомендуется стабилизировать форму эскиза геометрическими зависимостями
до того, как Вы определите размеры размерными зависимостями.

Размеры определяют длину, радиус или угол поворота геометрических элементов в
эскизе. В отличие от геометрических зависимостей, размеры являются
параметрическими; изменение их значений приводит к изменению геометрии.

Размеры можно отображать как числовые константы или как уравнения. Хотя Вы можете
использовать их вместо друг друга, каждый из них имеет свое специфическое
назначение.

• Числовые константы используют, когда геометрический элемент имеет постоянный
размер и не связан с каким либо другим геометрическим элементом.

• Уравнения используют, когда размер геометрического элемента пропорционален
размеру другого элемента.

В следующей иллюстрации, все линии и углы постоянные и отображаются числовыми
значениями.

В следующей иллюстрации, размеры отображаются как уравнения.

В этом случае, высота эскиза устанавливается пропорционально длине, даже если Вы
позже будете изменять размеры. В уравнении, Вы можете установить высоту
относительно длины. Размер вертикальной линии определен как уравнение
d1 = d0 / 0.875, где d1 - обозначение параметра для вертикальной линии, а d0 обозначение
параметра для одной из горизонтальных линий.

Переменные d в уравнениях – обозначения параметра, назначенные Mechanical Desktop
при определении параметров. Символ d указывает, что параметр является размером.
Цифра показывает порядковый номер размера.

Откройте файл sketch6.dwg в папке desktop\tutorial. Добавьте и измените размеры, чтобы
завершить определение следующего эскиза.

ОБРАТИТЕ ВНИМАНИЕ Сделайте резервную копию файлов учебных чертежей, чтобы
Вы имели оригинальные файлы на случай ошибки. См. «Резервное Копирование Файлов
Учебных Чертежей» на странице 7.



Mechanical Desktop Tutorials Release 4

52 Глава 2  Наложение Зависимостей на Эскиз

Эскизы до- и после- показывают, где необходимы размеры и порядок, в котором Вы
должны их разместить. Необходимые размеры здесь уже идентифицированы и
отображаются, как числовые константы.

Для предохранения формы эскиза от искажения при изменении размеров, сначала
указывают большие размеры: левая вертикальная линия (dim 1) и основание
горизонтальная линия (dim 2).

Добавляя геометрические зависимости, Вы можете уменьшать число требуемых
размеров. Позже, Вы сможете модифицировать эскиз меньшим количеством изменений.

После того, как основная форма будет определена, Вы замените крайнюю правую
вертикальную линию и верхнюю горизонтальную линию скруглениями и добавите
геометрические зависимости и размеры для завершения профиля.

Создание Эскизов Профиля

Сначала, преобразуйте эскиз без наложенных зависимостей к эскизу профиля до
добавления размеров. Затем исследуйте заданные по умолчанию геометрические
зависимости.

Для создания профиля из эскиза и проверка зависимостей
1. Создайте профиль из эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE

Mechanical Desktop перерисовывает эскиз и сообщает, что требуется еще шесть
размеров или зависимостей для определения эскиза:
Solved underconstrained sketch requiring 6 Dimensions or constraints.

(Для определения неопределенного эскиза требуется 6 размеров или зависимостей)
Проверьте выведенные геометрические зависимости, и определите, являются ли
заданные по умолчанию зависимости правильными и ограничивают ли они размеры,
добавляемые Вами.

2. Покажите зависимости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Show Constraints.

Пиктограмма Show Constraints

Меню Desktop Part → 2D Constraints → Show Constraints

Команда AMSHOWCON
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Ответьте на подсказку следующим образом:
Enter an option [All/Select/Next/eXit] <eXit>: Введите a

Mechanical Desktop повторно рассчитывает эскиз и отображает зависимости.

• Зависимость фиксации местоположения добавляется к начальной точке первой
линии эскиза.

• На приблизительно горизонтальные и вертикальные линии накладываются
горизонтальные (H) и вертикальные (V) зависимости.

• Приблизительно вертикальные линии становятся параллельными (P) друг к другу.

Для этого упражнения, все принятые геометрические зависимости правильны, и ни один
из них не ограничивает схему образмеривания, показанную ранее.

Ответьте на подсказку следующим образом:
Enter an option [All/Select/Next/eXit] <eXit>: Нажмите ENTER

Добавление Размеров

Теперь, когда упрощенный эскиз преобразован в эскиз профиля и заданные по
умолчанию геометрические зависимости наложены, Вы добавите четыре размера и две
геометрических зависимости для полного определения эскиза. Поскольку Вы уточняете
ваш проект, все геометрические зависимости поддерживаются, когда при изменении
параметрических размеров изменяются размеры детали.

Запомните следующие правила при добавлении размеров

• Выберите элементы для образмеривания и выберите, где разместить размер.

• Тип размера зависит от элемента, который Вы выбираете и где Вы размещаете
размер. Отображается текущий размер выбранного элемента.

• Вы можете указать расчетный размер или ввести новое значение.

• Элемент эскиза изменяется согласно значению размера и размер помещается в
местоположение, которое Вы выбрали.

Обычно оставляют автоматически рассчитанные размеры для стабилизирования формы
эскиза, особенно для больших габаритных размеров. Когда позже Вы приводите размеры
к точным значениям, менее вероятно, чтобы форма эскиза исказилась.
В этом упражнении, Вы создадите горизонтальные и вертикальные размеры. Затем, Вы
измените эскиз путем добавления геометрии и наложением угловых и радиальных
размеров.
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Для добавления размеров к профилю
1. Добавьте размеры к вашему профилю.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension
Меню Desktop Part → Dimensioning → New Dimension
Команда AMPARDIM

2. Ответьте на запросы  следующим образом:
Select first object: Выберите линию (1)

Select second object or place dimension: Разместите размер (2)

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<1.9606>: Введите 2

Solved underconstrained sketch requiring 5 Dimensions or constraints.

Эскиз изменяется в соответствии с новым значением размера.

Командная строка содержит несколько опций. Эти опции и число элементов, которые Вы
выбираете, определяют тип и размещение размеров.

В этом примере, Вы выбираете линию и размещаете размеры. Если бы Вы выбрали два
элемента и указали бы местоположение, Mechanical Desktop разместил бы размер,
который установил бы расстояние между этими двумя элементами.

3. Продолжите образмеривать эскиз, выбирая нижнюю горизонтальную линию.
Select first object: Выберите линию (3)

Select second object or place dimension: Разместите размер (4)

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<2.1123>: Введите 2

Solved underconstrained sketch requiring 4 Dimensions or constraints.

Select first object: Нажмите ENTER

Mechanical Desktop перерисовывает эскиз согласно новым значениям размеров.

Теперь, когда заданные по умолчанию зависимости и габаритные размеры определили
форму и размер эскиза, Вы можете начинать изменять эскиз. Для закрепления навыков и
модифицирования эскиза, Вы добавите скругления к двум сторонам эскиза.
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Для добавления скругления в углах
1. Используйте FILLET для ввода точек в показанном порядке.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching  → Fillet.

Пиктограмма Fillet
Меню Desktop Modify → Fillet
Команда  FILLET
Current settings: Mode = TRIM, Radius = 0.1250

Select first object or [Polyline/Radius/Trim]: Укажите линию (1)

Select second object: Укажите линию (2)

ОБРАТИТЕ ВНИМАНИЕ Поскольку Вы выбрали параллельные линии, команда FILLET
игнорирует значение радиуса и соединяет конечные точки выбранных линий
непрерывной дугой.

2. Наложите скругление на другие стороны эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Fillet.

Пиктограмма Fillet

Меню Desktop Modify → FILLET

Команда FILLET
Current settings: Mode = TRIM, Radius = 0.1250

Select first object or [Polyline/Radius/Trim]: Укажите линию (3)

Select second object: Укажите линию (4)

Ваш эскиз должен теперь походить на:

Перед тем, как Вы продолжите определять эскиз, сотрите горизонтальную и
вертикальную линии, соединяющие конечные точки новых дуг.
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3. Сотрите две линии.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Erase.

Пиктограмма Erase

Меню Desktop Modify → Erase

Команда ERASE

Ваш рисунок должен походить на:

Так как Вы изменили эскиз, Вы должны определить его прежде, чем используете его для
создания элемента.

Добавление Эскизов

Добавив скругления и удалив линии, Вы изменили геометрию эскиза. Всякий раз, когда
Вы добавляете, изменяете или удаляете геометрию, Вы должны добавить измененную
геометрию к эскизу профиля. Вас запросят выбрать любую новую геометрию, которую
Вы создали. Mechanical Desktop добавляет новую геометрию и повторно вычисляет
эскиз, назначая новые геометрические зависимости.

После добавления эскиза, повторно изучите геометрические зависимости, чтобы видеть,
не затрагивают ли они вашу схему образмеривания.

Для добавления эскиза профиля и повторного изучения геометрических
зависимостей

1. Разверните структуру PART1_1.

2. Добавьте скругления к существующей геометрии эскиза.

Обозреватель Щелкните правой кнопкой мыши Profile1 и выберите Append Profile
(Добавить Профиль).
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Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите, Sketch Solving → Append.

Пиктограмма  Append to sketch

Меню Desktop  Part → Sketch Solving → Append

Команда  AMRSOLVESK

3. Выберите две дуги, добавляемые к эскизу.
Select geometry to Append to sketch: Выберите первую дугу

Select geometry to Append to sketch: Выберите вторую дугу

Select geometry to Append to sketch: Нажмите ENTER

Redefining existing sketch.

Solved underconstrained sketch requiring 4 Dimensions or constraints.

Mechanical Desktop анализирует и перерисовывает профиль в соответствии со своими
правилами анализа эскиза. Необходимы четыре дополнительных зависимости для
полного определения эскиза.

4. Отобразите символы зависимости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Show Constraints.

Пиктограмма Show Constraints

Меню Desktop Part → 2D Constraints → Show Constraints

Команда AMSHOWCON

5. Отобразите все символы. Несколько касательных  зависимостей (T) добавляется к
первоначальным геометрическим зависимостям.

Касательные зависимости соединяют дуги с их смежными линиями. Обратите внимание,
что, хотя нумерация сегмента эскиза изменились из-за новой геометрии, зависимость
фиксации местоположения осталась в том же самом месте.

Для этого упражнения, не удаляйте никаких зависимостей, потому что касательные
зависимости не воздействуют неблагоприятно на схему образмеривания. Теперь, когда
Вы воссоздали эскиз профиля, Вы можете продолжать добавлять геометрические
зависимости и размеры к эскизу, начиная с радиусной зависимости для двух дуг.
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Для добавления зависимостей к воссозданному эскизу профиля
1. Добавьте радиусные зависимости к двум дугам.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Radius.

Кнопка Radius

Меню Desktop Design → 2D Constraints → Radius

Команда AMADDCON
Valid selection(s): arc or circle

Select object to be resized: Укажите дугу

Valid selection(s): arc or circle

Select object radius is based on: Укажите вторую дугу

Solved underconstrained sketch requiring 3 Dimensions or constraints.

Valid selection(s): arc or circle

Select object to be resized: Нажмите ENTER

[Hor/Ver/PErp/PAr/Tan/CL/CN/PRoj/Join/XValue/YValue/Radius/Length/Mir/Fix]

<eXit>: Нажмите ENTER

Mechanical Desktop добавляет радиусные зависимости к двум дугам.

Завершите определение эскиза добавлением трех размерных зависимостей.

2. Образмерьте крайнюю левую дугу.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

3. Ответьте на запросы следующим образом:
Select first object: Укажите нижнюю дугу

Select second object or place dimension: Разместите размер

Enter dimension value or [Undo/Diameter/Ordinate/Placement point]

<0.3687>: Введите 0.4

Solved under constrained sketch requiring 2 Dimensions or constraints.
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После того, как Вы введете новое значение радиуса, дуги изменятся, потому что
радиусная зависимость делает обе дуги равными.

4. Добавьте последние два размера, отвечая на запросы следующим образом:
Select first object: Укажите линию (1)

Select second object or place dimension: Разместите размер (2)

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.8753>: Введите 0.75

Solved underconstrained sketch requiring 1 Dimensions or constraints.

Select first object: Щелкните возле середины линии (1)

Select second object or place dimension: Щелкните возле середины линии (3)

Specify dimension placement: Разместите размер (4)

Enter dimension value or [Undo/Placement point] <138>: Введите 135

Solved fully constrained sketch.

Select first object: Нажмите ENTER

После помещения размеров, ваш эскиз должен полностью определится и походить на:

Сохраните Ваш файл.
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Изменение Размеров

Поскольку ваш проект изменяется в процессе проектирования, Вы должны уметь удалять
или изменять значения размеров. Параметрические команды Mechanical Desktop
гарантируют, что зависимости между геометрическими элементами останутся
нетронутыми. Вы измените размер верхней горизонтальной линии и углового размера.

Для изменения размера
1. Измените размеры для завершения эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → Edit Dimension.

Пиктограмма Edit Dimension

Меню Desktop Design → Dimensioning → Edit Dimension

Команда AMMODDIM

2. Ответьте на запросы следующим образом:
Select dimension to change: Укажите размер (1)

New value for dimension <.4>: Введите 0.375

Solved fully constrained sketch.

Select dimension to change: Укажите линию (2)

New value for dimension <.75>: Введите 0.5

Solved fully constrained sketch.

Select dimension to change: Нажмите ENTER

Ваш законченный эскиз должен теперь походить на:

Сохраните ваш файл.
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Использование Конструктивной Геометрии
Конструктивная геометрия может минимизировать число зависимостей и размеров,
необходимых в эскизе и предлагает много способов управления элементами эскиза.
Конструктивная геометрия хорошо работает с симметричными или геометрически
согласованными эскизами. Некоторые примеры - эскизы, которые имеют радиусную
геометрию, линии прямые или под углом к другой геометрии.

Конструктивная геометрия - любая линия, дуга или круг на профиле эскиза или
траектории, тип линии которой отличается от типа линии эскиза. По умолчанию,
конструктивная геометрия помещается на слой AM_CON. Чтобы сделать конструктивную
геометрию легкоразличимой, Вы можете изменять ее цвет, тип или масштаб.

Конструктивная геометрия может использоваться для ограничения только эскиза, с
которым она связана. Когда Вы создаете из эскиза элемент, Вы также выбираете
конструктивную геометрию с траекторией или эскизом профиля. После того, как элемент
будет создан, конструктивная геометрия больше не показывается.

Создание Эскизов Профиля

В этом упражнении Вы выполните типичную последовательность. Как всегда, изучите
эскиз, чтобы определить, какие требуются зависимости и размеры и определите, где
разместить конструктивную геометрию, чтобы сделать определение эскиза проще.

Откройте файла sketch7.dwg в папке desktop\tutorial.

ОБРАТИТЕ ВНИМАНИЕ Сделайте резервную копию файлов учебных чертежей, чтобы
Вы имели оригинальные файлы на случай ошибки. См. «Резервное Копирование Файлов
Учебных Чертежей» на странице 7.

Для создания одиночного эскиза профиля
1. Используйте команду PLINE для построения упрощенного эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Polyline.

Пиктограмма Polyline

Меню Desktop Design → Polyline

Команда PLINE

2. Определите эскиз.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE
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Автоматически выбирается полилиния.

Mechanical Desktop накладывает зависимости согласно тому, как Вы делали эскиз и
затем сообщает, что эскиз нуждается в шести или более дополнительных зависимостях.

4. Отобразите существующие зависимости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Show Constraints.

Пиктограмма Show Constraints

Меню Desktop Part → 2D Constraints → Show Constraints

Команда AMSHOWCON

4. Отобразите все принятые символы зависимостей. Каждая из восьми линий должна иметь
вертикальную или горизонтальную зависимость.

Затем, создайте конструкционную линию для ограничения эскиза.

ОБРАТИТЕ ВНИМАНИЕ Если вы начали эскиз с левого нижнего угла, удалите
зависимость фиксации местоположения, используя команду AMDELCON. Эта
зависимость не даст Вам спроецировать эскиз на конструкционную линию.

Для создания конструкционной линии
1. Создайте конструкционную линию.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Construction Line.

Пиктограмма Construction Line

Нарисуйте линию по диагонали поперек эскиза.

Mechanical Desktop рисует линию на новом слое по имени AM_CON. Линия желтая и
имеет тип линии HIDDEN. Поскольку тип линии отличается от той, которой рисуют эскиз,
линия считается конструктивной геометрией. Она используется только в этом эскизе.

2. Добавьте профиль.

Обозреватель Щелкните правой кнопкой мыши Profile1 и выберите Append Profile.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите, Sketch Solving → Append.

Пиктограмма  Append to Sketch

Меню Desktop  Part → Sketch Solving → Append

Команда  AMRSOLVESK

4. Выберите конструкционную линию.

5. Повторно исследуйте принятые зависимости.
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Добавление Проекционных Зависимостей

Mechanical Desktop нашел девять линий в эскизе. Эскиз требует еще двух зависимостей
для добавленной конструкционной линии.

Далее, спроецируйте конструкционную линию на каждую вершину, являющуюся
внутренним углом ступеньки.

Для размещения проекционной зависимости, укажите вершину и, затем, выберите
конструкционную линию. В зависимости от того, насколько близко к вершине нарисована
конструкционная линия, некоторые зависимости, возможно, уже наложились.

Для добавления конструкционной зависимости
1. Добавьте проекционные зависимости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Project.

Пиктограмма Project

Меню Desktop Design → 2D Constraints → Project

Команда AMADDCON

2. Ответьте на запросы следующим образом:
Valid selection(s): line, circle, arc, ellipse or Spline segment

Specify a point to project: Введите end

of: Укажите точку (1)

Valid selection(s): line, circle, arc, ellipse, work point or Spline segment

Select object to be projected to: Укажите конструкционную линию (5)

Valid selection(s): line, circle, arc, ellipse or Spline segment

Specify a point to project:

Повторите эту процедуру для точек (2) – (5), затем нажмите ENTER

ОБРАТИТЕ ВНИМАНИЕ Если Вы не используете объектную привязку к конечной точке,
Вы не сможете правильно определить эскиз.

Определяя наклон лестницы при помощи конструкционной линии, Вы уменьшили число
требуемых зависимостей и размеров до четырех.

3. Используйте команду REDRAW, чтобы очистить экран.

Меню Desktop View → Redraw

Команда REDRAW
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Добавление Параметрических Размеров

Для полного определения эскиза, образмерьте одну из ступенек и укажите угол наклона
для конструкционной линии. Поскольку ступеньки равны по высоте, Вы добавите
зависимости равной длины к оставшимся ступенькам позже.

Для добавления параметрических размеров
1. Добавьте размеры для определения ступенек.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

2. Ответьте на запросы  следующим образом:
Select first object: Щелкните возле середины конструкционной линии (1)

Select second object or place dimension:

Щелкните возле середины нижней горизонтальной линии (2)

Specify dimension placement: Укажите точку справа (3)

Enter dimension value or [Undo/Placement point] <31>: Введите 30

Solved underconstrained sketch requiring 3 Dimensions or constraints.

3. Продолжайте образмеривать эскиз, выбирая первую вертикальную ступеньку.
Select first object: Укажите точку в середине нижней левой вертикальной линии (4)

Select second object or place dimension: Укажите точку слева от первой точки (5)

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]
<0.9463>: Введите 1

Solved underconstrained sketch requiring 2 Dimensions or constraints.

Select first object: Нажмите ENTER
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Для завершения определения эскиза, добавьте размеры равной длины к оставшимся
двум ступенькам.

Для добавления зависимости равной длины
1. Создайте зависимость равной длины.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Equal Length.

Кнопка Equal Length

Меню Desktop Part → 2D Constraints → Equal Length

Команда AMADDCON

2. Ответьте на следующие запросы:
Valid selection(s): line or Spline segment

Select object to be resized: Укажите вторую ступеньку (2)

Valid selection(s): line or Spline segment

Select object to base size on: Укажите образмеренную ступеньку (1)

Solved underconstrained sketch requiring 1 Dimensions or constraints.

3. Продолжая в командной строке, разместите последнюю зависимость.
Valid selection(s): line or Spline segment

Select object to be resized: Укажите третью ступеньку (3)

Valid selection(s): line or Spline segment

Select object to base size on: Укажите образмеренную ступеньку (1)

Solved fully constrained sketch.

Вы должны получить полностью определенный эскиз. Выйдите из команды двойным
нажатием ENTER .
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4. Отредактируйте эскиз для изменения углового размера.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → Edit Dimension.

Пиктограмма Edit Dimension

Меню Desktop Design → Dimensioning → Edit Dimension

Команда AMMODDIM

5. Ответьте на запросы следующим образом:
Select dimension to change: Укажите угловой размер

New value for dimension <.4>: Введите 25

Select dimension to change: Нажмите ENTER

Сохраните ваш файл.

Наложение Зависимостей На Эскиз Траектории

Конструктивная геометрия помогает ограничивать эскизы, которые трудно ограничить
только геометрией формы эскиза. В этом упражнении, Вы создадите эскиз траектории,
добавите конструктивную линию и привяжете эскиз к линии.

Перед началом этого упражнения, создайте определение новой детали для эскиза.

Для создания определения новой детали
1. Создайте определение новой детали.

Обозреватель Щелкните правой кнопкой мыши в пустом месте окна и выберите
New Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Part → New Part.

Пиктограмма New Part

Меню Desktop Part → Part → New Part

Команда AMNEW

2. Нажмите ENTER в командной строке, чтобы принять заданное по умолчанию название
детали.

3. Панорамируйте рисунок так, чтобы получить достаточно места для создания следующего
эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Pan.

Пиктограмма Pan Realtime

Меню Desktop View → Pan → Realtime

Команда PAN

Вы готовы к следующему упражнению.
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Для использования конструктивной геометрии в траектории протягивания
1. Используйте команду PLINE для отрисовки следующего эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Polyline.

Пиктограмма Polyline

Меню Desktop Design → Polyline

Команда PLINE

Используйте опцию arc/direction (дуга/направление) команды PLINE для отрисовки дуги.
Вы можете также использовать указатель курсора для визуального выравнивания
конечных точек каждой дуги при создании эскиза.

ОБРАТИТЕ ВНИМАНИЕ Чтобы увеличить перекрестие, выберите Assist → Options. Под
Crosshair Size (Размер перекрестья), установите размер 15 или более.

2. Создайте 2D траекторию из вашего эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → 2D Path .

Пиктограмма 2D Path

Меню Desktop Design → Sketch Solving → 2D Path

Команда AM2DPATH

3. Ответьте на запросы следующим образом:
Select objects: Укажите полилинию

Select objects: Нажмите ENTER

Specify the start point of the path: Укажите одну из конечных точек траектории

Solved underconstrained sketch requiring 10 Dimensions or constraints.

Create a profile plane perpendicular to the path? [Yes/No] <Yes>: Введите n

Вы можете использовать любую конечную точку для привязки.

Mechanical Desktop сообщает, что эскиз нуждается в десяти или более дополнительных
зависимостях, в зависимости от того, как Вы рисовали эскиз.

4. Нарисуйте две конструкционные линии. Цель состоит в том, чтобы каждый из концов дуг
приходился на конструкционную линию.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Construction Line.

Пиктограмма Construction Line
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5. В Обозревателе, разверните структуру PART2_1.

6. Добавьте конструкционные линии к вашему эскизу.

Обозреватель Щелкните правой кнопкой мыши Profile1 и выберите Append Profile.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите, Sketch Solving → Append.

Пиктограмма  Append to Sketch

Меню Desktop  Part → Sketch Solving → Append

Команда  AMRSOLVESK

7. Ответьте на запросы  следующим образом:
Select geometry to Append to sketch: Выберите конструкционную линию

Select geometry to Append to sketch: Выберите вторую конструкционную линию

Select geometry to Append to sketch: Нажмите ENTER

Redefining existing sketch.

Specify start point of path: Укажите одну из конечных точек траектории

Solved underconstrained sketch requiring 6 Dimensions or constraints.

Конструкционные линии уменьшили число зависимостей или размеров, необходимых для
привязки конечных точек дуг и центров к линии. Конструкционные линии также стали
горизонтальными.

Для проверки и добавления отсутствующих зависимостей
1. Выясните, какие зависимости были наложены и которые еще необходимо наложить.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Show Constraints.

Пиктограмма Show Constraints

Меню Desktop Part → 2D Constraints → Show Constraints

Команда AMSHOWCON

2. Отобразите все зависимости и нажмите ENTER для выхода из команды.

3. Продолжайте ограничивать и образмеривать эскиз.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM
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4. Ответьте на запросы  следующим образом:
Select first object: Укажите верхнюю левую дугу (1)

Select second object or place dimension:

Укажите вертикальную линию слева и ниже ее середины (2)

Specify dimension placement: Укажите точку в левой части эскиза (3)

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]
<3.1069>: Введите 3

Solved underconstrained sketch requiring 5 Dimensions or constraints.

5. Добавьте второй размер.
Select first object: Укажите верхнюю левую дугу (1)

Select second object or place dimension:

Укажите точку вверху слева от эскиза (4)

Enter dimension value or [Undo/Diameter/Ordinate/Placement point]

<0.2788>: Введите 0.25

Solved underconstrained sketch requiring 4 Dimensions or constraints.

Select first object: Нажмите ENTER

Затем, Вы полностью определите траекторию, добавляя 2D зависимости.

6. Ограничьте все дуги тем же радиусом, которым только что образмеривали.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Radius.

Кнопка Radius

Меню Desktop Design → 2D Constraints → Radius

Команда AMADDCON

6. Ответьте на запросы следующим образом:
Valid selection(s): arc or circle

Select object to be resized: Укажите левую нижнюю дугу

Valid selection(s): arc or circle

Select object radius is based on: Укажите дугу с радиальным размером

Solved underconstrained sketch requiring 3 Dimensions or constraints.

Valid selection(s): arc or circle

Select object to be resized: Укажите верхнюю дугу, вторую слева
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Valid selection(s): arc or circle

Select object radius is based on: Укажите дугу с радиальным размером
Solved underconstrained sketch requiring 2 Dimensions or constraints.

Valid selection(s): arc or circle

Select object to be resized: Укажите нижнюю дугу, вторую слева
Valid selection(s): arc or circle

Select object radius is based on: Укажите дугу с радиальным размером
Solved underconstrained sketch requiring 1 Dimensions or constraints.

Valid selection(s): arc or circle

Select object to be resized: Укажите верхнюю правую дугу
Valid selection(s): arc or circle

Select object radius is based on: Укажите дугу с радиальным размером
Solved fully constrained sketch.

Valid selection(s): arc or circle

Select object to be resized: Нажмите ENTER

[Hor/Ver/PErp/PAr/Tan/CL/CN/PRoj/Join/XValue/YValue/Radius/Length/Mir/Fix]

<eXit>: Нажмите ENTER

Ваш эскиз должен быть теперь полностью определен. Поэкспериментируйте с ним,
изменяя значения этих двух размеров.

Если центры дуг не лежат на конструкционной линии, используйте проекционную
зависимость. Добавьте проекционные зависимости, пока эскиз полностью не ограничен.

ОБРАТИТЕ ВНИМАНИЕ В зависимости от того, насколько точно Вы сделали эскиз
траектории, Вам могут потребоваться другие зависимости. Экспериментируйте до
полного ограничения Вашего эскиза. Если у Вас не получается, удалите эскиз и
попытайтесь сначала.

Сохраните ваш файл.

Управление Касательными

Отдельная часть конструктивной геометрии может управлять размером и формой целых
эскизов. Круги и дуги особенно полезны для ограничения внешних форм гаек, ручек,
многогранных профилей и многоугольников обычной формы.

В этом упражнении, Вы создадите эскиз треугольника и, затем, наложите зависимости на
стороны треугольника и внутренние углы, чтобы они оставались равными. Этим
способом Вы можете формировать базу для семейства деталей, в которых единственная
переменная является единственным диаметральным размером.

Создайте определение новой детали для следующего эскиза.

Для создания определения новой детали
1. Создайте определение новой детали.

Обозреватель Щелкните правой кнопкой мыши в пустом месте окна и выберите
New Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Part → New Part.

Пиктограмма New Part

Меню Desktop Part → Part → New Part

Команда AMNEW
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2. Нажмите ENTER в командной строке, чтобы принять заданное по умолчанию название
детали.

3. Панорамируйте рисунок так, чтобы получить достаточно места для создания следующего
эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Pan.

Пиктограмма Pan Realtime

Меню Desktop View → Pan → Realtime

Команда PAN

Вы готовы к созданию следующего эскиза.

Для контроля касательности конструктивной геометрии
1. Используйте команду PLINE для создания треугольника.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и выберите
Контекстное Меню В графической области, щелкните
правой кнопкой мыши и выберите 2D Sketching → Polyline.

Пиктограмма Polyline
Меню Desktop Design → Polyline
Команда PLINE

2. Нарисуйте круг внутри треугольника

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching  → Construction Circle.

Пиктограмма  Construction Circle

3. Превратите эскиз в эскиз профиля, выбрав и полилинию и круг.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Profile.

Пиктограмма Profile

Меню Desktop Design → - Sketch Solving → Profile

Команда AMPROFILE
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На этом этапе круг может быть касательным к некоторым или всем сторонам
треугольника.

4. Добавьте касательные зависимости к эскизу.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и выберите
2D Constraints → Tangent.

Пиктограмма Tangent

Меню Desktop Design → 2D Constraints → Tangent

Команда AMADDCON

5. Ответьте на запросы следующим образом:
Valid selection(s): line, circle, arc, ellipse or Spline segment

Select object to be reoriented: Укажите линию (1)

Valid selection(s): line, circle, arc, ellipse or Spline segment

Select object to be made tangent to: Укажите круг (2)

Solved underconstrained sketch requiring 5 Dimensions or constraints.

Valid selection(s): line, circle, arc, ellipse or Spline segment

Select object to be reoriented: Укажите линию (3)

Valid selection(s): line, circle, arc, ellipse or Spline segment

Select object to be made tangent to: Укажите круг (4)

Solved underconstrained sketch requiring 4 Dimensions or constraints.

Valid selection(s): line, circle, arc, ellipse or Spline segment

Select object to be reoriented: Укажите линию (5)

Valid selection(s): line, circle, arc, ellipse or Spline segment

Select object to be made tangent to: Укажите круг (6)

Solved underconstrained sketch requiring 3 Dimensions or constraints.

Valid selection(s): line, circle, arc, ellipse or Spline segment

Select object to be reoriented: Нажмите ENTER

[Hor/Ver/PErp/PAr/Tan/CL/CN/PRoj/Join/XValue/YValue/Radius/Length/Mir/Fix]

<eXit>: Нажмите ENTER

 Mechanical Desktop теперь нуждается в трех или более размерах или зависимостях для
полного определения эскиза.

Для добавления размера к углам
1. Наложите угловые размеры на углы треугольника.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM
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2. Ответьте на запросы следующим образом:
Select first object: Щелкните в середине линии (1)

Select second object or place dimension: Щелкните в середине линии (2)

Specify dimension placement: Разместите размер (3)

Enter dimension value or [Undo/Placement point] <67>: Введите 60

Solved underconstrained sketch requiring 2 Dimensions or constraints.

2. Продолжите в командной строке.
Select first object: Щелкните в середине линии (2)

Select second object or place dimension: Щелкните в середине линии (5)

Specify dimension placement: Разместите размер (3) Введите 60

Solved underconstrained sketch requiring 1 Dimensions or constraints.

Select first object: Нажмите ENTER

ОБРАТИТЕ ВНИМАНИЕ Если Вы выберете линии не около их середин, Вас могут
запросить указать тип создаваемого размера. Выберите Angular (Угловой).

Угловой размер должен походить на следующую иллюстрацию

Для добавления размера к кругу
1. Добавьте размер к диаметру конструктивного круга.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

2. Ответьте на запросы  следующим образом:
Select first object: Укажите точку на круге

Select second object or place dimension: Укажите точку вне треугольника

Enter dimension value or [Undo/Radius/Ordinate/Placement point]
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<3.1541>: Введите 10

Solved fully constrained sketch.

Select first object: Нажмите ENTER

Эскиз теперь полностью определен.

3. Уменьшите масштаб изображения, что бы полностью показать весь эскиз.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Zoom.

Кнопка Zoom

Пиктограмма Zoom Realtime

Меню Desktop View → Zoom → Realtime

Команда ZOOM

ОБРАТИТЕ ВНИМАНИЕ Если сегмент основания вашего треугольника все еще не
горизонтален, Вы должны добавить горизонтальную зависимость для полного
определения эскиза.

3. Поэкспериментируйте с размером эскиза. Измените размер диаметра круга.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → Edit Dimension.

Пиктограмма Edit Dimension

Меню Desktop Design → Dimensioning → Edit Dimension

Команда AMMODDIM

4. Ответьте на запросы следующим образом:
Select dimension to change: Укажите размер диаметра

New value for dimension <10>: Введите 5

Solved fully constrained sketch.

Select dimension to change: Нажмите ENTER

Сохраните ваш файл.

Все стороны остаются равными по длине и касательными к кругу, а основание
треугольника остается горизонтальным. Если Вы использовали этот эскиз в качестве
основного элемента детали, Вы сможете изменять габаритный размер детали простым
изменением диаметра конструктивного круга.

Эта методика может применяться для более сложной геометрии типа пятиугольников,
восьмиугольников и многоугольников неправильной формы. Эти формы могут составлять
основной элемент семейства гаек, болтов, фитингов и так далее. Попробуйте создать
такие типы эскизов для ваших собственных нужд.


		2000-08-11T04:20:41-0800
	Kazan
	Alekseev Kirill
	I am the author of this document




